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Preface

As part of an effort to improve and enhance the performance and capabilities of its product 
lines, EMC periodically releases revisions of its hardware and software. Therefore, some 
functions described in this document may not be supported by all versions of the software or 
hardware currently in use. For the most up-to-date information on product features, refer to 
your product release notes.

If a product does not function properly or does not function as described in this document, 
please contact your EMC representative.

Audience This guide is part of the EMC NetWorker Module for Microsoft SQL Server 
documentation set, and is intended for use by system administrators during 
installation and setup of the product. Operators who monitor daily backups may also 
find this guide helpful.

Readers of this guide are expected to be familiar with the following:

◆ EMC NetWorker software
◆ Microsoft SQL Server versions 2000, 2005, and 2008

Related
documentation

Related documents include:

The following documentation provides additional information relevant to the use this 
NetWorker Module software:

◆ EMC NetWorker Module for Microsoft SQL Server Administration Guide

◆ EMC NetWorker Module for Microsoft SQL Server Installation Guide

◆ EMC NetWorker Module for Microsoft SQL Server Release Notes

◆ EMC NetWorker Module for Microsoft SQL Server Online Help

◆ EMC NetWorker PowerSnap Module version specific installation and 
administration guides

Documentation specific to the NetWorker server version are also available:

◆ EMC NetWorker Administration Guide

◆ EMC NetWorker Installation Guide

◆ EMC NetWorker Release Notes

Hardware and software compatibility guides are also available at: 
http://Powerlink.EMC.com
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Preface
Conventions used in
this document

EMC uses the following conventions for special notices.

Note: A note presents information that is important, but not hazard-related.

CAUTION!
A caution contains information essential to avoid data loss or damage to the system 
or equipment. 

IMPORTANT!
An important notice contains information essential to operation of the software. 

Typographical conventions
EMC uses the following type style conventions in this document:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, functions, utilities
• URLs, pathnames, filenames, directory names, computer names, filenames, links, 

groups, service keys, file systems, notifications

Bold Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system calls, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text 

Courier bold Used for:
• Specific user input (such as commands) 

Courier italic Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide6



Preface
Where to get help EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Powerlink 
website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on 
Powerlink. To open a service request through Powerlink, you must have a valid 
support agreement. Please contact your EMC sales representative for details about 
obtaining a valid support agreement or to answer any questions about your account.

Your comments Your suggestions will help us continue to improve the accuracy, organization, and 
overall quality of the user publications. Please send your opinion of this document to:

SSGdocumentation@EMC.com
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide 7
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Introduction
About NetWorker Module for SQL Server
The EMC® NetWorker® Module for Microsoft SQL Server, release 5.2 Service Pack 1, 
is a NetWorker module that provides backup and restore of the following database 
and transaction logs:

◆ Microsoft SQL Server 2008

◆ Microsoft SQL Server 2005

◆ Microsoft SQL Server 2000

This module integrates data protection procedures for Microsoft SQL Server 
databases with the NetWorker software. This provides a comprehensive storage 
management solution that addresses the need for cross-platform support of 
enterprise applications on UNIX and Microsoft Windows operating systems. 

Figure 1 on page 10 provides details on how the NetWorker Module for Microsoft 
SQL Server and NetWorker software work with SQL Server.

Figure 1 Module and NetWorker setup with SQL Server

In addition to traditional backup and recovery, NetWorker Module for Microsoft SQL 
Server also provides snapshot backup and recovery of SQL Server 2000, 2005, and 
2008 on Windows Server 2000, Windows Server 2003, and Windows Server 2008 
computers.
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Introduction
NetWorker PowerSnap Module support
NetWorker Module for Microsoft SQL Server supports NetWorker PowerSnap™ 
Modules, which interface with a snapshot-capable storage subsystem and the 
NetWorker and NetWorker Module for Microsoft SQL Server software. For a current 
list of supported storage subsystems, refer to the EMC Software Compatibility 
Guides.

By using the NetWorker PowerSnap Module appropriate for the SQL Server storage 
subsystem, you can create and manage point-in-time (PiT) copies, or snapshots, of 
Microsoft SQL Server data. For more information on PowerSnap Modules, refer to the 
EMC NetWorker PowerSnap Module guides for the specific storage subsystem.
NetWorker PowerSnap Module support 11
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Installation
Installation roadmap
The following roadmap provides an overview of the NetWorker Module for 
Microsoft SQL Server software installation tasks:

1. Review “Software requirements” on page 15.

2. Review “Installation prerequisites” on page 18.

3. Obtain the software as described in “Accessing the NetWorker Module 
installation files” on page 22.

4. Install the NetWorker Module software. For instructions, see “Installing the 
NetWorker Module software” on page 23.

5. Enable and register the NetWorker Module software. For instructions, see 
Chapter 3, “Licensing and Enabling the Software.”

NetWorker Module 
features

This release of NetWorker Module for Microsoft SQL Server offers several new 
features, including: 

◆ IPv6 support with NetWorker client, storage nodes, and servers configured for 
IPv6 support.

◆ Integration with the NetWorker 7.5 Client Configuration Wizard. This wizard 
enables simple backup configuration of the NetWorker Module for SQL Server 
client. To use the Configuration Wizard, NetWorker 7.5 server and client must be 
installed.

◆ Push install from a NetWorker 7.5 or later server. This enables a NetWorker server 
administrator to mount a DVD containing the NetWorker Module binaries, and 
push the installation of the module to a NetWorker client.

◆ Multiple language support.

Multiple language 
support

This module release has been translated into the following languages:

◆ Japanese

◆ Simplified Chinese

◆ French

◆ Korean

This release of the NetWorker Module for Microsoft SQL Server can be installed in 
these non-English environments. Ensure that the appropriate fonts are installed to 
support the chosen language.

Note: Full language support requires that the module is installed with the NetWorker 7.4 or 
later client.
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide14



Installation
Software requirements
This section specifies the software that is required for successful installation of 
NetWorker Module for Microsoft SQL Server software.

Supported operating systems
This module supports the following editions of Microsoft Windows:

◆ Windows 2000 with the latest service packs

◆ Windows Server 2003 with the latest service packs

◆ Windows Server 2008 with the latest service packs

See “Microsoft Windows and SQL Server compatibility” on page 15 for SQL Server 
and operating system compatibility with this module.

Microsoft SQL Server The NetWorker Module for Microsoft SQL Server software supports the following 
versions of Microsoft SQL Server:

◆ Microsoft SQL Server 2008 Express, Workgroup, Standard, Web, Compact, and 
Enterprise editions

◆ Microsoft SQL Server 2005 Express, Workgroup, Standard, and Enterprise 
editions

◆ Microsoft SQL Server 2000 Standard and Enterprise editions

Microsoft Windows and SQL Server compatibility
NetWorker Module for Microsoft SQL Server is compatible with Microsoft Windows 
and Microsoft SQL Server, as shown in Table 1 on page 15.

◆ With the Windows Server 2003 x64 operating system, the SQL Server, NetWorker, 
and the module software are supported in native mode. This module software 
does support SQL Server running in WOW64 mode.

Table 1 NetWorker Module compatibility

SQL Server versions Windows Server versions Cluster support

SQL Server 2008 (x86, x64)
SQL Server 2005 (x86, x64), 
service pack 2

Windows Server 2008 (x86, x64) Windows Server 2008 Enterprise edition 
Windows Server 2008 Datacenter edition

SQL Server 2008 (x86, x64, IA64)
SQL Server 2005 (x86, x64, 
IA64), service pack 2

Windows Server 2003 R2 (x64, 
x86, IA64)
Windows Server 2003 (x64, x86, 
IA64)
Windows 2000 (x86) 

Windows Server 2003 Enterprise edition
Windows Server 2003 Datacenter edition
\Windows 2000 Advanced Server
Windows 2000 Datacenter Server

SQL Server 2000 (x86, IA64), 
service pack 4 and hotfix 
KB913100

Windows Server 2003 R2 (x64, 
x86, IA64)
Windows Server 2003 (x64, x86, 
IA64)
Windows 2000 (x86) 

Windows Server 2003 Enterprise edition
Windows Server 2003 Datacenter edition
\Windows 2000 Advanced Server
Windows 2000 Datacenter Server
Software requirements 15
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◆ A Microsoft hotfix is required for the module running on Windows Server 2003 
x64 with SQL Server 2000. SQL Server 2000 Virtual Device Interface (Sqlvdi.dll) is 
a 32-bit DLL. The 64-bit Volume Shadow Copy Service (VSS) writer that is 
included with the x64 edition of Windows Server 2003 requires an x64 edition of 
Sqlvdi.dll to work correctly. The Microsoft knowledgebase article 
http://support.microsoft.com/kb/913100/ provides more information.

Note: The EMC software compatibility guide at http://Powerlink.EMC.com contains the 
latest supported platforms, qualifications, and service pack information for NetWorker and the 
modules.

NetWorker PowerSnap Module
The NetWorker PowerSnap Module software is required only if the NetWorker 
Module for Microsoft SQL Server software is to perform snapshot backup and 
recovery operations. For recovery of snapshot backups, PowerSnap Module software 
is not required on the target SQL Server host.

For snapshot backup support, the SQL Server host must have a supported 
snapshot-capable storage subsystem.

PowerSnap Module software requirements are as follows:

◆ The SQL Server host must have the appropriate PowerSnap Module installed.

◆ If a computer other than the SQL Server host is configured as the PowerSnap data 
mover (proxy client), the data mover host must have the following software 
installed:

• NetWorker software release 7.4 or later

• PowerSnap Module software appropriate for the storage subsystem

Table 2 on page 16 lists configurations for snapshot backup and recovery with 
NetWorker Module for SQL Server, release 5.2 SP1:

See the PowerSnap documentation and the EMC software compatibility guides for 
additional information.

Table 2 NetWorker Module and PowerSnap support 

SQL Server versions Operating System versions PowerSnap Arrays

SQL Server 2008 (x86)
SQL Server 2005 (x86)
SQL Server 2000 (x86)

Windows Server 2003 R2 (x86)
Windows Server 2003 (x86)

PowerSnap for Symmetrix® DMX

SQL Server 2008 (x86, x64)
SQL Server 2005 (x86, x64)
SQL Server 2000 (x86)

Windows Server 2003 R2 (x86, x64)
Windows Server 2003 (x86, x64)

PowerSnap for CLARiiON®

SQL Server 2008 (x86)
SQL Server 2005 (x86)
SQL Server 2000 (x86)

Windows Server 2003 R2 (x86)
Windows Server 2003 (x86)

PowerSnap for RecoverPoint
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide16
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NetWorker software The NetWorker client software must be installed on the SQL Server host computer. 
For more information about the installation requirements for NetWorker client 
software, refer to the appropriate EMC NetWorker Installation Guide. 

The NetWorker software requirements for NetWorker Module for Microsoft SQL 
Server software are as follows:

◆ NetWorker client and server software release 7.4 or later for internationalization 
and localization support.

◆ NetWorker client and server software release 7.4.2 or later for Windows Server 
2008 and SQL Server 2008 support.

Note: The nsr_render_log is required to view module logs and is supplied with NetWorker 
7.4 and later releases. For releases prior to 7.4, this can be obtained from EMC Customer 
Support.

◆ NetWorker client and server software release 7.5 or later for Client Configuration 
Wizard support.

◆ NetWorker client and server software release 7.5 or later for IPv6 support.

NetWorker Module for Microsoft SQL Server software can connect to and interact 
with a NetWorker server running on any supported operating system platform. 

Note: The NetWorker Configuration Wizard will not work with SQL Server 2008 unless the 
"Microsoft SQL Server 2005 Backward Compatibility Components" package is installed. The 
Configuration Wizard uses SQL-DMO to communicate with SQL Server, which was removed 
from SQL Server 2008. The backward compatibility package can be downloaded from 
http://www.microsoft.com/downloads/.

Software backward compatibility
This NetWorker Module software can successfully restore backups of all types made 
by NetWorker Module for SQL Server 4.0 and later.

NetWorker installation path

This guide refers to the root directory of the NetWorker installation path by using the 
variable NetWorker_install_path. The actual location represented by this variable 
depends on when and how the NetWorker software was installed.

The NetWorker default location is %SystemDrive%\Program Files\Legato\nsr.
Software requirements 17
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Installation prerequisites
Before installing the NetWorker Module for Microsoft SQL Server, verify that the 
following prerequisites are met:

◆ The SQL Server host must meet the installation requirements. For details, see 
“Software requirements” on page 15.

◆ The SQL Server host must have enough disk space available for the software 
installation:.

Temporary files created during installation require additional space. After the 
installation is complete, the temporary files are deleted.

◆ The NetWorker client software must be installed on the SQL Server host.

◆ Any previous release of this module must be removed before you begin an 
installation of release 5.2 SP1. 

◆ The installation operator must have Windows domain administrator privileges. 
The release notes provide more information on creating generic configurations for 
users. 

Table 3 Space requirements for 32-bit platforms

Installation type Space needed

Typical – English 6.8 MB

Custom – NetWorker Module software 6.0 MB

Custom – Configuration Wizard 896 KB

Table 4 Space requirements for x64 platforms 

Installation type Space needed

Typical – English 9.1 MB

Custom – NetWorker Module software 8.3 MB

Custom – Configuration Wizard 896 KB

Table 5 Space requirements for ia64 platforms

Installation type Space needed

Typical 15.6 MB
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide18
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The upgrade option
Selection of the upgrade option in the NetWorker Module for Microsoft SQL Server 
software setup program automatically removes a previous release of the software. 
Registry entries are also removed.

CAUTION!
Removing the module software deletes certain registry setting configurations. This 
includes any pool settings you specified in the NetWorker User for SQL Server 
Backup Options dialog box. Make a record of the pool settings. The Backup 
Options dialog box is accessed from the Options menu when you select Backup 
Options in the NetWorker User for SQL Server program.

There are two ways to manually remove an earlier release of this module:

◆ Use the Windows Add/Remove feature in the Control Panel.

◆ Complete the following steps:

1. Access the directory on the CD or hard drive from which you installed the 
previous NetWorker Module for Microsoft SQL Server release.

2. Run setup.exe to start the module Setup program. Because the software is 
already installed, the Setup program runs in maintenance mode. Click Next.

3. Click Remove, and then click Next.

4. In the Remove the Program dialog box, click Remove.

Note: When removing the module software from a Microsoft cluster, you must perform this 
procedure on each physical cluster node.
The upgrade option 19
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Where to install the NetWorker Module
The NetWorker client software and the NetWorker Module for Microsoft SQL Server 
software must both be installed on the SQL Server host. The NetWorker server 
software may be installed on the SQL Server host, or on a separate computer.

◆ A NetWorker server is a system running the NetWorker server software with a 
connected backup storage device. 

◆ A NetWorker client is a system running the NetWorker client software, which 
receives storage management services from the NetWorker server. 

After you install the NetWorker Module for Microsoft SQL Server software, configure 
the SQL Server host as a client of the NetWorker server.

On the same computer

To take advantage of NetWorker immediate-save technology, install the NetWorker 
server software on the SQL Server host. Immediate saves improve backup 
performance because the data is not moved over the network. However, do not install 
the NetWorker server software on the SQL Server host if the NetWorker server 
supports a large numbers of clients. The SQL Server host and NetWorker software 
compete for the same system resources when installed on the same computer.

In this configuration, consider using a NetWorker storage node. For instructions on 
configuring and using a storage node, refer to the EMC NetWorker Administration 
Guide.

Note: The immediate save feature is available with a NetWorker Power Edition license.
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide20
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On separate computers

Typically, the NetWorker server software resides on one computer and the SQL 
Server software on another, as shown in Figure 2 on page 21.

Figure 2 Configuration example
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Accessing the NetWorker Module installation files
This section explains how to access the NetWorker Module for Microsoft SQL Server 
software installation files from the following locations.

To access the installation files from a CD:

1. Load the NetWorker Module for Microsoft SQL Server CD in the SQL Server host 
or a remote server.

2. If installing from a remote server, create a shared volume for the CD drive.

3. Log in with administrator privileges to the Windows computer that is running the 
SQL Server.

4. Start Windows Explorer and select the CD drive.

5. To complete the installation, see “Installing the NetWorker Module software” on 
page 23.

To access the installation files from the EMC website:

1. In your web browser, navigate to www.EMC.com.

2. Under Resources, click the Evaluation Software link.

The Evaluation Software Request page appears. 

3. Click the Search by Product list, select NetWorker Module for Microsoft SQL 
Server from the list, and then select Release 5.2 SP1 from the list of releases.

4. On the Evaluation Software Request form, enter contact information and submit 
it. 

You will receive an email message from an EMC sales representative, with your 
assigned username, password, and a URL to the NetWorker Module download 
file on the FTP site.

5. After you receive this email, create a temporary directory to download the 
software.

6. Navigate to the website specified in the email, and log on with your assigned 
username and password.

7. Download the NetWorker Module evaluation software to the temporary 
directory.

8. To complete the installation, follow the steps in “Installing the software” on 
page 23. 
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide22
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Installing the NetWorker Module software
First determine if any of these situations apply: 

◆ If you plan to use Microsoft Systems management Server (SMS) to install the 
module software, see “Microsoft cluster environments” on page 26. 

◆ If you plan to use the module software in a Microsoft cluster, see “Microsoft 
cluster environments” on page 26.

◆ If you plan to use the NetWorker Configuration Wizard to configure scheduled 
backups see “Configuring scheduled backups” on page 23.

Configuring scheduled backups

To use the NetWorker Configuration Wizard to configure NetWorker Module for 
Microsoft SQL Server scheduled backups:

1. Install the NetWorker client software.

2. (Optional) Install the NetWorker Configuration Wizard. 

Note: The NetWorker Configuration Wizard will not work with SQL Server 2008 unless the 
"Microsoft SQL Server 2005 Backward Compatibility Components" package is installed. 
The Configuration Wizard uses SQL-DMO to communicate with SQL Server, which was 
removed from SQL Server 2008. The backward compatibility package can be downloaded 
from http://www.microsoft.com/downloads/.

3. Install the NetWorker Module for Microsoft SQL Server software. 

4. Ensure that the hostname of the computer that is running the wizard is included 
in the /nsr/res/servers or NetWorker_install_path\res\servers file on the 
NetWorker Module for Microsoft SQL Server client (or the servers file is empty).  
If the servers file is not empty, it must also include the hostnames of all the 
NetWorker servers authorized to back up the client.

Installing the 
software

To install the NetWorker Module for Microsoft SQL Server software:

1. Verify that the target computer satisfies the requirements. For details, see 
“Software requirements” on page 15.

2. Ensure that prerequisites have been met. For details, see “Installation 
prerequisites” on page 18.

3. Log in with administrator privileges to the target computer.

4. Exit all NetWorker programs.

5. In Windows Explorer, go to the directory containing the NetWorker Module for 
Microsoft SQL Server installation files. The content of this directory depends on 
the source for the module software:

• If from the CD, this directory contains setup.exe. 

• If from the EMC website, this directory contains nmsql521_win_x86.exe (32-bit), 
nmsql521_win_x64.exe (x64), or nmsql521_win_ia64.exe (ia64).

6. Double-click the appropriate executable file.

The Welcome dialog box is displayed. 
Installing the NetWorker Module software 23
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• If this is a new installation of NetWorker Module for Microsoft SQL Server, 
proceed to step 7. 

• If a previous version of the NetWorker Module is already installed, the 
Welcome dialog box provides an Upgrade button and offers to upgrade the 
software. In this case, click Upgrade, and then Install, and proceed to step 9.

• If the module software is already installed, the Welcome dialog box offers to 
repair or remove the software. In this case, click Next and then proceed to 
either “Repairing an installation” on page 34 or “Removing an installation by 
using the setup program” on page 35.

7. Click Next. The License Agreement dialog box appears.

8. Read the license agreement. If you accept the terms, select the appropriate option 
and click Next.

Note: If Microsoft SQL Server is not yet installed on this computer, a message prompts you 
to install it before using the NetWorker Module for Microsoft SQL Server program. Click 
OK to continue with the installation.

9. If the NetWorker Configuration Wizard is not installed, skip this step and proceed 
to step 11.

If the NetWorker Configuration Wizard is installed, the Setup Type dialog box 
appears.

In the Setup Type dialog box, select one of the following and click Next:

• Complete — Automatically installs the module software and the module 
Server component of the NetWorker Configuration Wizard.

• Custom — Enables you to install the module software, the wizard component, 
or both.

Note: If you opt to install only the module software (without the wizard component) 
during the initial installation, you can run setup.exe in maintenance mode later and 
install the wizard component. For instructions, see “Maintaining a NetWorker Module 
installation” on page 32.

10. If you selected Complete in step 9, the Server dialog box appears. Skip this step 
and proceed to step 11.

If you selected Custom, the Custom Setup dialog box appears. 

Installation of module Server component of the NetWorker Configuration Wizard 
lets you use the wizard to configure scheduled backups of SQL Server data. 

To exclude the module Server component of the NetWorker Configuration 
Wizard from the installation:

a. Click the NetWorker Module for Microsoft SQL Server Client Configuration 
Wizard icon.

b. Select This feature will not be available. 

11. In the Server dialog box, select one of the following:

• To specify a NetWorker server that can back up the SQL Server host, enter the 
name of the NetWorker server in the Default NetWorker Server text box.

• To use the local computer as the NetWorker server, leave the Default 
NetWorker Server text box blank.

12. Click Next. The Ready to Install the Program dialog box is displayed.
EMC NetWorker Module for Microsoft SQL Server Release 5.2 Service Pack 1 Installation Guide24
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13. Click Install to begin the installation.

The Setup program performs the following:

• Adds NetWorker User for SQL Server to the NetWorker group in the Windows 
Start menu.

• Installs the module software in the <NetWorker_install_path>\bin directory.

Note: For more information about the NetWorker installation path, see “NetWorker 
installation path” on page 17.

14. In the InstallShield Wizard Completed dialog box, click Finish to exit the 
wizard.
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Microsoft cluster environments
TheNetWorker Module for Microsoft SQL Server software can be installed in a 
Microsoft cluster and configured to do the following:

◆ Perform backup and recover operations in a Microsoft Cluster Server (MSCS) 
environment. 

◆ Provide backup and restore capability for SQL Server data stored on the cluster 
disks of a virtual server.

The software also can perform backup and restore for failover cluster configurations 
in SQL Server 2000, 2005, or 2008 environments. 

For each physical cluster node, the NetWorker client and NetWorker Module for 
Microsoft SQL Server software must be installed on a private disk owned by the 
node. Do not install the module software on a shared cluster disk.

The Microsoft product documentation provides details about cluster and SQL Server 
configuration and compatibility requirements.

Installing the software in a Microsoft cluster

To install NetWorker Module for Microsoft SQL Server software in an MSCS cluster:

1. Install the NetWorker client software on a local disk of each physical node in the 
cluster. 

Note: Install the module software into the default NetWorker installation directory.

During the installation, you are prompted to specify the hostnames of NetWorker 
servers that are authorized to back up the client’s data. The list of authorized 
servers is stored in the NetWorker_install_path\res\servers file on the NetWorker 
client:

• For snapshot backups in a Microsoft cluster, the servers file on each cluster 
node must either contain the hostnames of all nodes in the cluster, or be blank 
(contain no hostnames). 

• For traditional backup operations, you do not need to list cluster hostnames in 
the servers file. 

For instructions on editing the servers file after the NetWorker software 
installation, refer to the EMC NetWorker Administration Guide.

Note: A NetWorker client’s servers file that does not contain any hostnames could be a 
security risk because any NetWorker server would have access to the client’s data.

2. Install the module software on the local disk of each physical node in the cluster. 

The software is automatically installed at the same location as the NetWorker 
client software. See “Installing the NetWorker Module software” on page 23 for 
additional information.
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3. Install the enabler for this module. For more information, see Chapter 3, 
“Licensing and Enabling the Software.”

4. (Optional) If the SQL Server has a snapshot-capable storage subsystem, install the 
appropriate NetWorker PowerSnap Module. For instructions on installing and 
configuring the software in a Microsoft cluster, refer to the appropriate EMC 
NetWorker PowerSnap Module guide.
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Configuring and testing the installation
This section provides information about testing and verifying the NetWorker Module 
for Microsoft SQL Server software installation. To verify that the module software is 
installed properly, you must first configure the SQL Server host as a NetWorker client 
and enable the Autostart option. 

Perform a test backup of SQL Server by using NetWorker Module for Microsoft SQL 
Server to ensure that:

◆ The necessary components are installed and configured properly.

◆ The NetWorker server can access the SQL Server host and perform a scheduled 
backup. 

Configuring the NetWorker Module
Due to the complexity of configuring scheduled backups, complete one of the 
following before you begin the configuration: 

◆ Perform a manual backup.

◆ Use the NetWorker Configuration Wizard to configure a basic scheduled backup.

Before you use the NetWorker Module for Microsoft SQL Server software to back up 
the databases managed by SQL Server, you must configure the NetWorker server to 
run with the module by creating the following:

◆ A backup Group resource for scheduled backups of SQL Server. For instructions, 
see “Creating a backup group for scheduled backups” on page 29.

◆ A Client resource for the client host on which you installed the module. For 
instructions, see “Creating a NetWorker client” on page 29.

For more information, refer to the documents listed in Table 6 on page 28.

Note: The following set of instructions for creating a backup group and NetWorker client are 
specific to running the NetWorker Administrator program from a Windows computer. To 
perform these procedures from a UNIX computer, refer to the EMC NetWorker Administration 
Guide.

Table 6 Reference documentation

Type of information Documentation

For using the NetWorker Administrator program or the NetWorker 
Configuration Wizard to configure scheduled backups and add 
clients to the NetWorker server.

EMC NetWorker Administration Guide

For using the module software with the NetWorker server to perform 
backups and restores.

EMC NetWorker Module for Microsoft 
SQL Server Administration Guide
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Creating a backup group for scheduled backups

The following instructions provide basic detail on the procedures for the current 
versions of NetWorker software.

To create a group: 

1. From the Administration window of the NetWorker Management Console, click 
Configuration. 

2. In the expanded left pane, select Groups. 

3. From the File menu, select New. 

4. In the Name attribute, enter a name for the group. 

5. In the Comment attribute, enter a description of the group. 

6. For the Start Time attribute, enter a new time, unless it is appropriate to maintain 
the default time of 3:33 a.m. Ensure that start times for different groups are far 
enough apart so that one group has completed backing up before the next group 
starts. 

7. For the Autostart attribute, select Enabled. 

8. In the Printer attribute, enter the name of the printer on which bootstrap save set 
information will be printed. 

9. Click Advanced. 

10. For the Client Retries attribute, change the number of retries, if necessary.  This 
value specifies the number of times the NetWorker software attempts to back up a 
failed client. 

11. Click OK. 

Creating a NetWorker client

The SQL Server host must be configured as a NetWorker client by using the Client 
resource in the NetWorker Administrator program. The Client resource provides the 
NetWorker server with information about the following:

◆ The data to back up for a client.

◆ How long to maintain entries for the data in the online index for restoring 
(browse policy).

◆ How long to keep the media containing the client’s backed-up data (retention 
policy). 

You can configure each Microsoft SQL Server database on the same host as a separate 
NetWorker Client resource. 

Note: When the NetWorker Server is a UNIX server, a scheduled backup may require the 
Remote User and password field to be populated with a SQL administrator account in the 
format domain\username.  It should be noted that if the password for this account is changed, 
the remote password field for the client instance will also need to be updated or the backups 
will fail.

For a clustered SQL client, enter information for the account performing the backups.
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To add and configure a new NetWorker client:

1. From the Administration window of the NetWorker Management Console, click 
Configuration.

2. In the expanded left pane, select Clients.

3. From the File menu, select New.

4. In the Name attribute, enter the DNS name of the SQL Server host.

5. In the Save Set attribute, specify the items to back up.

For example, to back up all databases on the SQL Server host, enter:

MSSQL:

To back up a named instance, enter:

MSSQL$<instancename>:db_name

6. From the Group attribute, select the newly created backup group. 

7. From the Schedule attribute, select Default.

8. From the Browse Policy attribute, select a browse policy.

9. From the Retention Policy attribute, select a retention policy.

10. Click Preferences.

11. Enter the attributes information on the General tab except for the following:

• In the Aliases attribute on the Globals (1 of 2) tab, enter the nicknames for the 
client computers that queries can match. Otherwise, queries match only the 
client name. Each Client resource should include both the DNS short name 
and long name.

• In the Backup Command attribute on the Apps & Modules tab, enter the 
following command (with the appropriate command options):

nsrsqlsv

12. Click OK to save the configuration.

Configuring volume 
pools

You can create or edit destination volume pools for scheduled backups in the 
NetWorker Administrator Pools resource. For details on using pools, refer to the 
EMC NetWorker Administration Guide and the EMC NetWorker Module for Microsoft 
SQL Server Administration Guide.

Starting a test 
backup

The NetWorker Module for Microsoft SQL Server backup of a SQL Server database is 
always a full backup. A full backup backs up the entire database, including 
uncommitted transactions in the logs. The full backup accurately reflects the state of a 
live database, including all transaction log data, at approximately the time the backup 
completes. As the backup ends, the old logs are truncated and the logs begin 
collecting transaction data again. 

If you do not assign specific pools before performing a scheduled backup, the 
database and transaction log backup data are automatically directed to the media 
pools selected on the NetWorker server. If no pools are selected on the NetWorker 
server, backup data is automatically directed to the NetWorker preconfigured pool 
called Default.
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CAUTION!
A backup cannot run if there is no media volume mounted in the backup device. 
Make sure that a labeled media volume is mounted in the backup device before 
starting a backup. The volume should be labeled for the volume pool where the 
backup is to be directed. If there is no volume in the backup device when a backup 
is started, no messages appear in the Backup Status window.

To test the SQL Server backup you scheduled in the NetWorker Administration 
program:

Note: When a group backup is started manually, the NetWorker server runs the backup at the 
level of the next scheduled backup, such as full, level [1 – 9], incremental, or consolidated.

1. From the Administration window, click Monitoring.

2. Click Groups.

3. Right-click the group to start, then select Start.

4. Click Yes to confirm the start.

The NetWorker server immediately backs up the clients in the group, overriding the 
scheduled backup start time. The group icon changes to the clock icon until the 
backup has completed or is interrupted.
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Maintaining a NetWorker Module installation
After NetWorker Module for Microsoft SQL Server software is installed, you can run 
the Setup program in maintenance mode to repair or remove the existing installation.

Running the setup program in maintenance mode
When NetWorker Module for Microsoft SQL Server is already installed, the Setup 
program automatically runs in maintenance mode:

1. Log in with administrator privileges to the target computer.

2. Exit all NetWorker programs.

3. In Windows Explorer, go to the directory that contains the module software setup 
files (setup.exe). 

4. In the Welcome to the InstallShield Wizard for NetWorker Module for 
Microsoft SQL Server dialog box, click Next.

The Setup program detects the existing NetWorker Module for Microsoft SQL 
Server installation and automatically displays the Program Maintenance dialog 
box, as in Figure 3 on page 32.

Figure 3 Program Maintenance dialog box

5. Select the task you want to perform, then proceed to the appropriate procedure to 
complete the maintenance task:

• Modify — Add new features to the existing installation.

Note: Modify is available for a NetWorker Module for Microsoft SQL Server that is 
running in 32-bit mode. Modify is not available if it is running in a 64-bit mode. Only 
the SQL Server Backup and Recovery component is available for 64-bit installations.

• Repair — Replace missing or corrupted program files, or repair registry 
entries and shortcuts in the existing module installation. For instructions, see 
“Repairing an installation” on page 34.
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• Remove — Use the Setup program’s installation removal function to remove 
the module software. Alternatively, you can use the Add/Remove program in 
the Windows Control Panel to remove the module software installation. For 
instructions, see “Removing the NetWorker Module software” on page 35.

Adding program features to an installation

To add program features to an existing NetWorker Module for Microsoft SQL Server 
installation:

1. In Windows Explorer, go to the directory that contains the module software setup 
files and run the setup.exe program. 

Because the software is already installed, the Setup program now runs in 
maintenance mode.

2. In the Program Maintenance dialog box, select Modify, and click Next.

3. In the Custom Setup dialog box, click the icon of each program feature to be 
installed and select This feature will be installed on local hard drive, as in 
Figure 4 on page 33.

Figure 4 Custom Setup dialog box

4. Click Next.

The Server dialog box appears. 

5. In the Server dialog box, enter the hostname of the default NetWorker server to 
which the NetWorker User for SQL Server program will connect when started. 

If you do not enter a default NetWorker server, NetWorker User for SQL Server 
attempts to connect to the local host.

6. In the Ready to Modify dialog box, click Install to begin the installation.

The Setup program then adds the selected program features to the existing 
installation.
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Repairing an installation

To repair an existing NetWorker Module for Microsoft SQL Server software 
installation:

1. In Windows Explorer, go to the directory that contains the module software setup 
files and run the setup.exe program.

Because the software is already installed, the Setup program now runs in 
maintenance mode. 

2. In the Program Maintenance dialog box, select Repair, and then click Next.

3. In the Ready to Repair dialog box, click Install to begin the installation.

The Setup program reinstalls the module software files as necessary.
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Removing the NetWorker Module software
You can remove an existing installation of the NetWorker Module for Microsoft SQL 
Server either by using the Setup program, or the Windows Add/Remove Programs 
tool.

Note: When removing the module software from a cluster, you must perform the procedure on 
each cluster node.

Removing an installation by using the setup program

To remove a NetWorker Module for Microsoft SQL Server installation by using the 
Setup program:

1. In the Windows Explorer, go to the directory that contains the module software 
setup files and run the setup.exe program.

Because the software is already installed, the Setup program now runs in 
maintenance mode. 

2. Click Next.

3. In the Program Maintenance dialog box, select Remove, and click Next.

4. In the Remove the Program dialog box, click Remove. 

The Setup program removes all module software program files and registry settings.

Removing an installation by using the Add/Remove Programs tool

To remove a NetWorker Module for Microsoft SQL Server installation by using the 
Windows Add/Remove Programs tool:

1. From the Windows server, click the Start menu and select the Control Panel.

2. From the Control Panel, select Add/Remove Programs.

3. From the Add/Remove Programs window, select NetWorker Module for 
Microsoft SQL Server.

4. Click Remove.
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Licensing and Enabling the Software
How NetWorker software is licensed
NetWorker software and added features, such as modules, are installed in evaluation 
mode with all of the features enabled for a period of 30 days. The licensing of  
NetWorker software means entry of enabler and authorization codes on the server for 
the  NetWorker environment. Without these codes, the software or added features 
will not run beyond the evaluation period.

Each installation of  NetWorker server software must be licensed with a base enabler. 
This enabler “turns on” the software and allows you to use a particular bundle of 
features, such as a specified number of clients and devices. All licensing takes place 
on the server. The licenses are entered and stored on the server. The server enforces 
the licensing.

Base enablers come in different editions, which enable varying degrees of 
functionality. Add-on enablers allow a broader scope of features.

The steps in this chapter assume that the  NetWorker software is installed and that all 
of the software and hardware requirements have been met on the computer that will 
access the NetWorker Management Console.

NetWorker Module for Microsoft SQL Server licensing
The NetWorker Module for SQL Server supports the following two configurations:

◆ Standalone (non-clustered)

One license is required per physical machine. Multiple SQL Server instances may 
be installed.

◆ MSCS Active-Passive Cluster (one node is active and the other node(s) is used for 
failover)

One NetWorker Module license is required per SQL virtual server.  NetWorker 
Module for SQL Server licenses in an active-passive cluster environment are 
based on the number of SQL virtual servers.  For example, in a cluster that has 
two nodes and four SQL virtual servers, four NetWorker Module licenses are 
needed to backup the four SQL virtual servers.

The following are example scenarios:

◆ On a SQL stand-alone server, where SQL Server supports multiple instances, only 
one NetWorker Module license is required.

PhysicalServer1, 10.0.000.100, SQL Server instance -> 1 license

◆ In a SQL cluster, where SQL Server allows only one instance per SQL virtual 
server, NMSQL requires a license for each name/IP address combination.

VirtualServer1, 10.0.000.101, SQL Server -> 1 license

VirtualServer2, 10.0.000.102, SQL Server -> 1 license

VirtualServer3, 10.0.000.103, SQL Server -> 1 license

Note: The SQL Server host can also be licensed on a dedicated storage node to allow for 
LAN-free data protection. 
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The evaluation process
You can evaluate  NetWorker software two ways:

◆ By evaluating a new installation of the software on a  NetWorker server

◆ By evaluating  NetWorker features on an existing  installation

Evaluating a new installation

When you first install the  NetWorker software, you can evaluate it with all the 
modules and features for 30 days free without entering any codes.

By the end of the evaluation period, you must purchase, enter, and authorize a base 
enabler to continue to use the NetWorker software to back up data. The base enabler 
is the license that enables the edition purchased. 

To continue to use some of the modules and features that were available with the 
evaluation software, you might need to purchase add-on enablers, depending on the 
edition of the base enabler.

Evaluating features on an existing installation
If you are evaluating one or more NetWorker Modules or features on an edition of  
NetWorker software that has already been installed and enabled, enter a temporary 
enabler for each module or feature. The temporary enabler is valid for 45 days. 

To obtain a temporary enabler code, do one of the following:

◆ Go to the http://Powerlink.EMC.com website, select Support > Software 
Downloads and Licensing > License Management, and then follow the 
instructions for your product.

◆ Refer to the EMC Information Protection and Availability Product Families Media 
Kit.

An alert message is generated 15 days before a NetWorker license is about to expire. 
The alert remains until the NetWorker license is authorized or deleted.

To view the license alert:

◆ From the NetWorker Administration window, click Monitoring, and select the 
Alert tab.

◆ From the Console window, click Events. 

By the end of the evaluation period, you must purchase, install, and authorize the 
corresponding license enablers to continue to use modules or features you have 
evaluated. “The licensing process” on page 40 provides instructions.

Entering a temporary enabler code for NetWorker server release 7.3 or later
To enter the temporary enabler code:

1. Start the  Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a  server in the Enterprise list.
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c. In the right pane, select the application.

d. From the Enterprise menu, click Launch Application. 

The Administration window is launched as a separate application.

3. From the Administration window, click Configuration.

4. In the left pane, select Registration.

5. From the File menu, select New.

6. In the Enabler Code attribute, type the enabler code.

7. (Optional) In the Comment attribute, type a description of the license.

8. Click OK.

The licensing process
To permanently use  NetWorker software, you must purchase and enter a license 
enabler code, and then authorize it. This licensing process is the same for all editions 
of  NetWorker software as well as for individual modules and features. 

The license enabler code that you purchase is valid for 45 days, as a registration 
period. During the registration period, you must obtain and enter a corresponding 
authorization code. More instructions for purchasing, enabling, and authorizing the 
NetWorker software are provided in the section “NetWorker Module for Microsoft 
SQL Server licensing” on page 38.

IMPORTANT!
Automatically importing and installing the NetWorker license enablers and 
authorization codes from EMC Powerlink® is the recommended way to obtain and 
install  license enablers and authorization codes. Do not perform the tasks in the 
section “Manually enter and authorize the license enabler” on page 43 unless you 
cannot import and install automatically.

Automatically import NetWorker license enablers and authorization codes from Powerlink
Automatically import and install NetWorker license enablers and authorization codes 
from EMC Powerlink Licensing directly to a NetWorker server or a License Manager 
system by using the following procedures.

Download the NetWorker license enabler codes from EMC Powerlink Licensing
You can install the NetWorker licenses to a local NetWorker server, a remote 
NetWorker server, or to a License Manager system.

To download the license enabler codes from EMC Powerlink:

1. Go to the EMC Powerlink website (registration required) at 
http://Powerlink.EMC.com.

2. Select Support > Software Downloads and Licensing > License Management, 
and then select NetWorker from Licensing D-Q and follow the instructions for 
your product. The Powerlink Licensing Home page appears.
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Note: If the LAC # has not yet been entered, activated, and associated with the host ID, 
follow the instructions in the email received from EMC Licensing before proceeding to the 
next step.

3. On the Powerlink Licensing Home page, select Download Enabler Codes in the 
NetWorker Tools section.

The Search for Downloading Enabler Codes page appears.

4. For the %HostID attribute, enter a valid HostID.

5. Click Search.

The Search for Downloading Enabler Codes page appears, displaying the list of 
hosts that match the criteria.

6. Click the HostID that matches the criteria.

The Download page appears.

7. Click Download Enablers, then separately click the Download CSV, Download 
nsradmin, and Download ReadMe buttons to download and save these three 
files:

• ReadMe file

This file describes the process and how to use nsradmin to load the enablers.

– Format: ReadMe_<HostID>_<Date>.txt
– Example: ReadMe_df010b3f_20080814.txt

• nsradmin file

This file loads into nsradmin. 

– Format: <HostID><date>.nsradmin
– Example: df010b3f_20080814.nsradmin

• CSV file

This file contains the enabler codes and the information related to them, 
including part descriptions, part numbers, and authorization (auth) codes. 
You can import this file into Excel and search and sort the contents.

– Format: <hostID>.csv
– Example: df010b3f.csv

These files can be downloaded at any time from Powerlink.

Note: As additional licenses are added to a host profile, these new licenses will be included in 
future downloads.

Apply the NetWorker license enabler codes 
Perform the following to apply enabler codes:

1. Ensure that you have the following permissions on the NetWorker server. The 
permissions differ for Windows, Linux, and UNIX:

• Windows: Administrator

• UNIX and Linux: root

2. Identify the location where the files were downloaded.
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3. Run the following nsradmin command from the directory where the source_file is 
located. 

Note: The nsradmin command can be run from any NetWorker client, storage node, or 
server. 

• To install the NetWorker licenses on the NetWorker server, type this 
command:

nsradmin -i source_file > output_file

• To install the NetWorker licenses on a remote NetWorker server, type this 
command:

nsradmin -i source_file -s server_name > output_file

• To install the NetWorker licenses on a License Manager system, type this 
command:

nsradmin -i source_file -s server_name -p lgtolmd > output_file

4. Open and review the output_file for success or failure messages to ensure that the 
NetWorker licenses have been properly installed. 

• Success message in the output file.

If the first attempt to load a license was successful, a message similar to the 
following appears in the output file:

C:\PROGRA~1\Legato\nsr\bin\std>nsradmin -i infile
created resource id 25.0.0.20.96.108.23.72.137.69.168.135(1)
Current query set
updated resource id 25.0.0.20.96.108.23.72.137.69.168.135(2)

• Failure message in the output file.

If a license load failed, a message similar to one of the following might appear:

– This message in the output file indicates that the license already exists in 
NetWorker and can be ignored:
C:\PROGRA~1\Legato\nsr\bin\std>nsradmin -i infile
create failed: A license enabler already exists with enabler 
code xxxxxx-xxxxxx-xxxxxx
Current query set
updated resource id 25.0.0.20.96.108.23.72.137.69.168.135(3)

Note: If the nsradmin command has previously been run on a host, failure 
messages might be generated for NetWorker licenses that already exist.

– This message in the output file indicates that the NetWorker server 
processes are not running on the system. To work around this issue, start 
the NetWorker processes on the NetWorker server:
C:\PROGRA~1\Legato\nsr\bin\std>nsradmin -i infile pasb-tomp
39078:nsradmin: RPC error: Program not registered (severity 4, 
number 15)

Provide feedback
To provide feedback:

◆ If error messages appear in the output file or you would like to provide feedback, 
contact EMC Licensing.

◆ If you cannot determine the reason for a failure or experience problems with 
updating the NetWorker license, contact EMC Customer Support. You can open a 
Service Request on http://Powerlink.EMC.com. 
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Manually enter and authorize the license enabler

These sections explain how to enter and authorize the license enabler manually: 

1. “Enter the license enabler code for NetWorker server release 7.3 or later” on 
page 43

2. “Obtain an authorization code” on page 44

3. “Enter the authorization code” on page 44

Enter the license enabler code for NetWorker server release 7.3 or later

Note: To save time when entering multiple licenses, enter the base enabler last. Otherwise, once 
a base enabler is entered, devices that do not yet have licenses entered may be disabled. Those 
devices would have to be reenabled manually after their licenses are installed.

To enter the license enabler code:

1. Start the  Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, click a  server in the Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registrations.

5. From the File menu, select New. 

The Create Registration dialog box appears.

6. In the Enabler Code attribute, type the enabler code.

7. (Optional) In the Comment attribute, type a description of the license.

8. Click OK.

The new license is added and appears in the right pane. Repeat step 1  to step 8  to 
add any additional enabler codes.

After you type a license enabler code, you have 45 days as a registration period to 
authorize the  software. An alert message is generated 15 days before a NetWorker 
license is about to expire. The alert remains until the NetWorker license is authorized 
or deleted.

To view the license alert:

◆ From the NetWorker Administration window, click Monitoring and select the 
Alert tab.

◆ From the Console window, click Events. 
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Obtain an authorization code

IMPORTANT!
http://Powerlink.EMC.com  > License Management. If the software or feature is 
not authorized by the end of the 45-day registration period, the  backup function or 
feature is disabled. However, data that was backed up during the registration 
period can still be recovered from local devices.

Enter the authorization code
To complete the licensing process, you must enter the unique authorization code on 
the  server within 45 days of entering the license enabler code.

If the authorization process is successful, the expiration date for the license displays:

Authorized - No expiration date.

If the authorization is not verified in this way, contact the 
http://Powerlink.EMC.com.

To avoid an interruption in scheduled backups if you move the  software from one 
computer to another, or to change the network address of a computer after the 
software is installed, perform one of the following:

◆ Obtain a new authorization code. You need the host ID of the original server as 
well as the new server. The host ID appears in the server’s Registration window. 

◆ Install and configure the NetWorker License Manager software. “Managing 
licenses” on page 47 provides information on use of the NetWorker License 
Manager, and the latest NetWorker License Manager Installation and 
Administration guide.

To enter the authorization code:

1. Start the  Management Console software.

2. Open the Administration window:

a. In the Console window, click Enterprise.

b. In the left pane, select a  server in the Enterprise list.

c. In the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 

The Administration window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registration. 

5. In the right pane, select a license.

6. From the File menu, select Properties.

7. In the Auth Code attribute, type the authorization code for the product. The 
authorization code is the code assigned to the specified permanent enabler or 
update enabler code.

8. Click OK.

The license is now permanently enabled.
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Update enablers

To update existing  software to a major release, an update enabler is necessary. With a 
first-time purchase of  software, a one-year update agreement may be included. After 
a year, an update enabler may be acquired with a new update agreement purchase.

Update enabler code for updating from NetWorker releases prior to release 7.5
When updating from an earlier NetWorker release to release 7.5, the required update 
enabler is ea7e6c-a61631-bf0db0.

IMPORTANT!
Be sure to apply the update enabler before upgrading to NetWorker release 7.5. 
Contact EMC Licensing within 45 days to have the update enabler permanently 
authorized. 

NetWorker simplified licensing for virtual environments 
NetWorker introduces a simplified licensing model for virtualized environments. The 
EMC Software Compatibility Guide provides a detailed list of supported server 
virtualization environments.

Two new attributes have been added to the General tab of the Client resource to 
identify the client as a virtual client:

◆ Virtual Client — If the client is a virtual client, set the attribute to Yes by selecting 
the Virtual Client attribute checkbox.

◆ Physical Host — If the client is a virtual client, set the attribute to the hostname of 
the primary/initial physical machine hosting the virtual client.

Virtual Edition Client Connection license 

A new license type, Virtual Edition Client Connection, works with all server 
virtualization environments supported by the NetWorker software. 

The host identified in the Physical Host attribute consumes one Virtual Edition Client 
Connection license, regardless of how many virtual clients are running on that host. If 
a virtual machine is licensed on one physical host and then migrates to another 
physical host, the new physical host requires its own Virtual Client Connection 
license. The hostname does not need to be fully qualified, and must be less than 64 
bytes. All clients sharing the same physical host must use an identical name; do not 
mix name formats such as short, FQDN, or IP address.

To free a Virtual Client Connection license that has been assigned to a physical host, 
all references to the physical host must be removed by either of the following:

◆ Changing the Virtual Client and/or Physical Host attribute in the Client resources 
for all virtual clients that reference the physical host.

or

◆ Deleting all Client resources for virtual clients that reference the physical host. 

Licensing changes for NetWorker Modules in virtual environments
When NetWorker Module software is running natively on one or more virtual 
machines, one module license per module type is consumed per physical host, 
regardless of the number of virtual clients associated with that physical host. The 
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physical host itself also requires a Virtual Edition Client Connection license. Every 
physical machine that might host virtual clients with modules should be licensed in 
this way.

One license is required for each application type (SQL, Exchange, SharePoint, Oracle, 
SAP) used within all of the virtual machines on a single physical server. There are no 
changes to model codes for NetWorker Modules, so use existing codes and license 
enablers.

Also, for module licenses that specify the operating system, operating system 
restrictions are not enforced for modules running on virtual clients, allowing the 
physical host to run multiple types of virtual operating systems without regard for 
operating system restrictions in the module license.

Applying the Virtual Client license to an existing VM after upgrading from a previous release
The Virtual Client Connection license is not automatically applied to an existing VM 
after upgrading to NetWorker release 7.5. As a result, the VM uses one standard client 
license for the pre-existing virtual client instead of using the virtual client license.

To take advantage of the Virtual Edition Client Connection licensing policies and free 
up the use of the standard client license, select the Virtual Client attribute checkbox 
for this client's resource, and specify the Physical Host attribute.

Licensing changes for VMware Consolidated Backup 
When VMware Consolidated Backup (VCB) is being used, each proxy backup host 
consumes one standard Client Connection license, regardless of how many virtual 
clients are configured to back up through the proxy backup host.

Additional licenses
This section describes a few of the additional licenses required to operate some of the  
features.

Client connection licenses

Every computer to be backed up in a  datazone requires a client connection license, 
even the  server. The client connection license may be one of the licenses that is 
supplied with the base enabler or purchased separately. An NDMP data server 
requires a special type of client connection license.

Note: ClientPak® enablers are no longer required. Client licensing is now based solely on the 
client connection enablers.

Storage nodes
Each storage node requires a storage node license, in addition to its client connection 
license. A dedicated storage node, which allows the storage node to back up only 
itself, is licensed separately.

Cluster clients
Cluster clients no longer require a separate license. Each physical node in a cluster 
consumes one regular Client Connection license.
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HomeBase Server and Agent

The HomeBase Server and Agent have separate licensing schemes and require 
separate enablers. The following documentation provides more information on 
HomeBase licensing:

◆ EMC HomeBase Server Installation and Administration Guide

◆ EMC HomeBase Agent Installation and Administration Guide

Managing licenses
The NetWorker License Manager software provides centralized license management, 
which enables you to maintain all of an enterprise’s  licenses from a single computer. 
With the NetWorker License Manager, you can move  software from one computer to 
another, or change the IP address on an existing  server without having to reauthorize 
the software. The NetWorker License Manager can be installed as an option during 
the  software installation.

To begin to implement the NetWorker License Manager:

1. Obtain bulk enabler codes at http://Powerlink.EMC.com.

2. Install the NetWorker License Manager software.

3. Configure the NetWorker License Manager software.

4. Configure the NetWorker servers to access the NetWorker License Manager for 
their licenses.

The latest NetWorker License Manager Installation and Administration Guide 
provides more information on how to install and use the NetWorker License 
Manager.
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This appendix describes how to set permissions for the NetWorker Module for 
Microsoft SQL Server on Windows Server 2003.

This appendix includes the following section:

◆ Setting access rights for the NetWorker Module ......................................................  50

Setting Permissions on
Windows Server 2003
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Setting access rights for the NetWorker Module
The NetWorker Module for Microsoft SQL Server on Windows Server 2003 requires 
access to various system folders and resources. By default, non-administrator user 
accounts are limited and do not have the necessary privileges to run the NetWorker 
Module. The following steps enable a local system administrator to configure these 
user accounts to run the NetWorker Module for Microsoft SQL Server.

To grant the permissions to NetWorker Module for Microsoft SQL Server for accounts 
that are not the members of the local administrator group, set the following registry 
and file objects permissions:

1. Make sure that the security settings on the applogs directory, under the 
NetWorker Module for Microsoft SQL Server installation path, allow Modify. 
(The default installation path is C:\Program Files\Legato\nsr\applogs).

2. Make sure that the following registry keys have the following permissions set:

Native registry keys

• HKLM\Software\Legato\BSMSQL\Environment (Full)

• HKLM\Software\Microsoft\DataAccess (Read)

• HKLM\Software\Microsoft\MSSQLServer (Read)

• HKLM\Software\Microsoft\Microsoft SQL Server (Read)

WOW64 registry keys (32-bit SQL Server on 64-bit systems)

• HKLM\Software\Wow6432Node\Microsoft\MSSQLServer (Read)

• HKLM\Software\Wow6432Node\Microsoft\Microsoft SQL Server (Read)

3. Make sure that the account is also:

• Able to Create Global Objects under the local Security Policy, which is 
required by the SQL VDI interface used by this module.

• A member of the Backup Operator’s group.

• Included in the sysadmin role within SQL Server.

The Microsoft SQL Server product documentation provides complete procedures for 
these tasks.
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